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8. Documenter

8.1 An Overview to the Documenter

8.1.1 General

The Documenter allows the user to create a project documentation of his application program.

Essentially the Documenter generates the listings of function charts and state charts.  Additionally, signal
cross references sorted by cluster/segments or signal groups will be created.

A tree will be used to show the whole project hierarchy.  The tree can be edited by the user with the functions
zoom/unzoom and contract/expand. In the tree the user can select the project objects he wishes to have a
document of it.  Project objects can be one or multiple bus, devices, tasks, domains, clusters, segments,
signal groups, macros or subcharts.

8.1.2 Inputs

The Documenter uses the application data of the project database (project.ER).  The Documenter reads from
the database, but does not write to it.  Several libraries will be used:
- The library PTSDOC.LIB contains the user specified data for the front page, the footer data and printer

defaults.  (The user must have read/write access to this library.)
- The library PRINTER.LIB contains the printer drivers.
- The library PTSRSC.LIB contains footer frames and resources.

8.1.3 Outputs

The generated listings will be written into the current work directory.  For one list command (item 'Print') one
list file will be generated.  All listings have the file extension .LST.  Following file names are used by default:
- FrontPag.LST for project front page.
- SegChart.LST for FUP/ALS charts with abstract and with or without signal cross reference.
- MacChart.LST for macro charts.
- SegXRef.LST for signal cross reference by cluster/segments.
- GrouXRef.LST for signal cross reference by signal groups.
- SegTree.LST for tree of cluster/segment.
- GrouTree.LST for tree of signal groups.
- SigMap.LST for tree of bus, devices, domains, signal groups, signals.
- TasMap.LST for tree of bus, devices, tasks, clusters, segments.
- MacTree.LST for tree of macros.
- LocParam.LST for cluster local parameters
- GloParam.LST for global parameters

The file names may be changed by the user.  The charts will be built in the listing in the same way as in the
Editor.
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8.1.4 Abbreviations

The abbreviations in the tree have following meaning:
CL: cluster
FUP: function diagram
ALS: state transition diagram
SUB: subchart

The expressions in cross reference have following meaning:
Source: stands for source cluster/segment
Sink: stands for destination cluster/segment

8.2 Starting the Documenter

To start the Documenter from operating system level (DOS) enter the following command:

PTSDoc

To start the Documenter from the Shell select the 'Documenter' item in the 'Tools' menu section.

8.3 Manipulating the Windows

The 'Windows' menu is available in all interactive FUPLA 2 applications.  The five menu items allow to move,
resize, and slide the windows.  Sometimes only a subset of the window manipulations is available on certain
windows.

8.4 The 'System' Menu

There are two system functions in the 'System' menu section:

About ...: Choose this item to get some information about the system such as release
information, copyright remark or available memory space.

Exit: Choose this item to leave the Documenter and return to the DOS level or Shell
level.

┌────────────────────────────────────────────────────────────────────────────────┐
│ Windows System Enter Select Layout Print View Setup Options │
│ ╔═════════╗ │
│ ║About ...║ │
│ ║Exit ║ │
│ ╚═════════╝ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
└────────────────────────────────────────────────────────────────────────────────┘
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8.5 The 'Enter' Menu

There are two functions in the 'Enter' menu section to modify the front page and the footer of each sheet, one
function to enter document type specific information and a 'Help' function:

Front Page Data: Choose this item to enter information for the front page of your project
documentation.

Project Footer Data: Choose this item to enter information for the footer on each sheet of your project
documentation.

Doc. Type Footer Data: Choose this item to enter document type specific information.

Help: Choose this item to get an on-line help for the Documenter.

┌────────────────────────────────────────────────────────────────────────────────┐
│ Windows System Enter Select Layout Print View Setup Options │
│ ╔════════════════════╗ │
│ ║Front Page Data ║ │
│ ║Project Footer Data ║ │
│ ║Doc.Type Footer Data║ │
│ ║Help ║ │
│ ╚════════════════════╝ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
└────────────────────────────────────────────────────────────────────────────────┘

8.5.1 Enter Front Page Data

After selecting the 'Front Page Data' item the form 'Front Page Data' is opened, which allows you to enter
data.  To edit any text item select this item with the mouse or the 'Tab' key and enter text with the keyboard.
Pressing the 'Save' or 'Cancel' button closes the form.

'Save' saves the edited text and closes the window.

'Cancel' closes the window without saving.

NOTE: Use the backspace or 'Del(ete)' key to remove wrong entered text.
Use the 'ESC' key to delete a whole line.

┌────────────────────────────────────────────────────────────────────────────────┐
│ Windows System Enter Select Layout Print View Setup Options │
│ ╔Front Page Data═════════════════════════════╗ │
│ ║ ║ │
│ ║ ABB Asea Brown Boveri_________ ║ │
│ ║ ║ │
│ ║ PSR System________________ ║ │
│ ║ ║ │
│ ║ Project: User Manual___________________ ║ │
│ ║ ║ │
│ ║ Title: Front-Page Example____________ ║ │
│ ║ ║ │
│ ║ Customer: Anybody_______________________ ║ │
│ ║ ║ │
│ ║ Site: Office________________________ ║ │
│ ║ ║ │
│ ║ Order: 1-359'800-921_________________ ║ │
│ ║ ║ │
│ ║ Supplier: ABB Drives AG_________________ ║ │
│ ║ ║ │
│ ║ █▀▀▀▀▀▀▀▀▀▀█ ╔══════════╗ ║ │
│ ║ █ Save █ ║ Cancel ║ ║ │
│ ║ █▄▄▄▄▄▄▄▄▄▄█ ╚══════════╝ ║ │
│ ╚════════════════════════════════════════════╝ │
│ │
│ │
└────────────────────────────────────────────────────────────────────────────────┘
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8.5.2 Enter Project Footer Data

After selecting the 'Project Footer Data' item the form 'Project Footer Data' is opened, which allows you to
enter data.  To edit any text item select this item with the mouse or the 'Tab' key and enter text with the
keyboard. Pressing the 'Save' or 'Cancel' button closes the form as explained in section 8.5.1.

NOTE: To enter the segment title use the 'Title' item of the 'Enter' menu
section in the Editor.

┌────────────────────────────────────────────────────────────────────────────────┐
│ Windows System Enter Select Layout Print View Setup Options │
│╔Project Footer Data═══════════════════════════════════════════════════════════╗│
│║ ║│
│║ derived from: _________________ ║│
│║ ║│
│║ replaces : _________________ checked : _________________ ║│
│║ ║│
│║ replaced by : _________________ std. checked: _________________ ║│
│║ ║│
│║ office resp.: nobody___________ released : _________________ ║│
│║ ║│
│║ project name: User Manual_________________ ║│
│║ ║│
│║ title : ____________________________ ║│
│║ ║│
│║ free field : ____________________________ nr. of shts.: ____ ║│
│║ ║│
│║ = front : ________ language : engl_ ║│
│║ ║│
│║ + : ____________________________ scheme nr. : HIEE 455360 R001 ║│
│║ ║│
│║ █▀▀▀▀▀▀▀▀▀▀█ ╔══════════╗ ║│
│║ █ Save █ ║ Cancel ║ ║│
│║ █▄▄▄▄▄▄▄▄▄▄█ ╚══════════╝ ║│
│╚══════════════════════════════════════════════════════════════════════════════╝│
└────────────────────────────────────────────────────────────────────────────────┘

8.5.3 Enter Document Type Specific Footer Data

After selecting the 'Doc. Type Footer Data' item a form selector is opened which allows you to select the
document type.

┌────────────────────────────────────────────────────────────────────────────────┐
│ Windows System Enter Select Layout Print View Setup Options │
│ ╔Document Type Specific Footer Data╗ │
│ ║ ┌──────────────────────────┐ ║ │
│ ║ │Front Page ││ ║ │
│ ║ │Cluster Segment Tree │ ║ │
│ ║ │Signal Group Tree │ ║ │
│ ║ │Task Map │ ║ │
│ ║ │Signal Map │ ║ │
│ ║ │Macro Tree │ ║ │
│ ║ │Segment Charts │ ║ │
│ ║ │Macro Charts │ ║ │
│ ║ │Xref by Segment │ ║ │
│ ║ │Xref by Signal Group │ ║ │
│ ║ │Global Parameters │ ║ │
│ ║ │Cluster Local Parameters │ ║ │
│ ║ │Configuration │ ║ │
│ ║ │Text File ││ ║ │
│ ║ └──────────────────────────┘ ║ │
│ ║ ║ │
│ ║ █▀▀▀▀▀▀▀▀▀▀█ ╔══════════╗ ║ │
│ ║ █ OK █ ║ Cancel ║ ║ │
│ ║ █▄▄▄▄▄▄▄▄▄▄█ ╚══════════╝ ║ │
│ ╚══════════════════════════════════╝ │
│ │
│ │
└────────────────────────────────────────────────────────────────────────────────┘

After a document type has been selected and the form has been exited with the 'OK' button, another form is
opened which allows to enter the document specific information footer data. This information is filled into the
footer frames of all listings of the corresponding listing type. Some document types (e. g. segment charts) do
not allow to specify all items, because they are filled out by the program itself (e. g. cluster and segment
name).  Enter the document specific information as explained previously.
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┌────────────────────────────────────────────────────────────────────────────────┐
│ Windows System Enter Select Layout Print View Setup Options │
│ ╔Front Page════════════════════════════════════════════════╗ │
│ ║ ║ │
│ ║ changed[0] : ___________________ ║ │
│ ║ ║ │
│ ║ changed[1] : ___________________ ║ │
│ ║ ║ │
│ ║ changed[2] : ___________________ ║ │
│ ║ ║ │
│ ║ changed[3] : ___________________ ║ │
│ ║ ║ │
│ ║ issued : _________________ ║ │
│ ║ ║ │
│ ║ doc.type : Front ║ │
│ ║ ║ │
│ ║ name : Front Page________________________________ ║ │
│ ║ ║ │
│ ║ title : __________________________________________ ║ │
│ ║ ║ │
│ ║ = back : /Frontpage__________ ║ │
│ ║ ║ │
│ ║ █▀▀▀▀▀▀▀▀▀▀█ ╔══════════╗ ║ │
│ ║ █ Save █ ║ Cancel ║ ║ │
│ ║ █▄▄▄▄▄▄▄▄▄▄█ ╚══════════╝ ║ │
│ ╚══════════════════════════════════════════════════════════╝ │
└────────────────────────────────────────────────────────────────────────────────┘

8.6 Displaying the Trees

Before a tree is to be displayed, the kind of the tree must be selected. The first five items in the 'Select' menu
section allows this selection.

The 'Segment' item displays the complete tree of clusters and segments as shown in the next figure.  The
clusters and segments are sorted in alphabetical order.

The 'Signal Group' item displays the tree of all signal groups looks similar to this one.  The signal groups
and signals are sorted in alphabetical order.

The 'Task Map' item displays the tree of all bus, devices, tasks, clusters and segments.  Bus and devices are
sorted in alphabetical order. The tasks, clusters and segments are sorted in execution order.

The 'Signal Map' item displays the tree of all bus, devices, domains and signal groups.  The nodes are
sorted in alphabetical order.

The 'Macros' item displays the tree of all macros.  They are sorted in alphabetical order.

┌────────────────────────────────────────────────────────────────────────────────┐
│ Windows System Enter Select Layout Print View Setup Options │
│ ╔══════════════╗ │
│ ║Segments ║ │
│ ║Signal Groups ║ │
│ ║Task Map ║ │
│ ║Signal Map ║ │
│ ║Macros ║ │
│ ║--------------║ │
│ ║Max Levels ║ │
│ ║Indent/Level ║ │
│ ║Help ║ │
│ ╚══════════════╝ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
└────────────────────────────────────────────────────────────────────────────────┘

Now, select the maximum number of levels which shall be loaded into the trees using the 'Max Levels' menu
item.  A form with radio buttons will be opened which allows to select the desired number of levels with the
mouse or the Up/Down Arrow keys. Pressing the 'OK' button activates the selection and closes the form.
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┌────────────────────────────────────────────────────────────────────────────────┐
│ Windows System Enter Select Layout Print View Setup Options │
│ │
│ │
│ │
│ ╔ Max Levels ══════════════════╗ │
│ ║ ║ │
│ ║ ┌Max Levels To Load From DB┐ ║ │
│ ║ │· root only · 9 levels │ ║ │
│ ║ │· 2 levels · 10 levels │ ║ │
│ ║ │· 3 levels · 11 levels │ ║ │
│ ║ │· 4 levels · 12 levels │ ║ │
│ ║ │· 5 levels · 13 levels │ ║ │
│ ║ │· 6 levels · 14 levels │ ║ │
│ ║ │· 7 levels · 15 levels │ ║ │
│ ║ │· 8 levels · 16 levels │ ║ │
│ ║ └──────────────────────────┘ ║ │
│ ║ ║ │
│ ║ █▀▀▀▀▀▀▀▀▀▀█ ╔══════════╗ ║ │
│ ║ █ OK █ ║ Cancel ║ ║ │
│ ║ █▄▄▄▄▄▄▄▄▄▄█ ╚══════════╝ ║ │
│ ╚══════════════════════════════╝ │
│ │
│ │
│ │
│ │
└────────────────────────────────────────────────────────────────────────────────┘

Next, select the maximum number of characters a tree branch should be indented using the 'Indent/Level'
menu item. A form with radio buttons will be opened which allows to select the desired number of characters
with the button or the Up/Down Arrow keys.  Pressing the 'OK' button activates the selection and closes the
form.

┌────────────────────────────────────────────────────────────────────────────────┐
│ Windows System Enter Select Layout Print View Setup Options │
│ │
│ │
│ │
│ ╔ Indent/Level ════════════════╗ │
│ ║ ║ │
│ ║ ┌Indent/Level [characters]─┐ ║ │
│ ║ │· 0 (no lines at all) │ ║ │
│ ║ │· 1 · 6 · 11 │ ║ │
│ ║ │· 2 · 7 · 12 │ ║ │
│ ║ │· 3 · 8 · 13 │ ║ │
│ ║ │· 4 · 9 · 14 │ ║ │
│ ║ │· 5 · 10 · 15 │ ║ │
│ ║ └──────────────────────────┘ ║ │
│ ║ ║ │
│ ║ █▀▀▀▀▀▀▀▀▀▀█ ╔══════════╗ ║ │
│ ║ █ OK █ ║ Cancel ║ ║ │
│ ║ █▄▄▄▄▄▄▄▄▄▄█ ╚══════════╝ ║ │
│ ╚══════════════════════════════╝ │
│ │
│ │
│ │
│ │
│ │
│ │
└────────────────────────────────────────────────────────────────────────────────┘

The following example shows a segment tree with three levels. The project is the top level. The clusters and
the segments are shown in the next lower levels.

┌────────────────────────────────────────────────────────────────────────────────┐
│ Windows System Enter Select Layout Print View Setup Options │
│╔═══════════════════════════════════════════════════════════╗ │
│║PROJECT DEBUG ║ │
│║ ├──CL:@MONITOR ║ │
│║ │ └──FUP:@MONITOR ║ │
│║ ├──CL:PTSPARAM-TEST-01 ║ │
│║ │ ├──FUP:SEG-01 ║ │
│║ │ ├──FUP:SEG-02 ║ │
│║ │ └──FUP:SWITCH0 ║ │
│║ ├──CL:TESTCLUSTER ║ │
│║ │ ├──FUP:FRED0 ║ │
│║ │ ├──FUP:PARAM ║ │
│║ │ └──FUP:SWITCH0 ║ │
│║ └──CL:UTILITY ║ │
│║ ├──FUP:DUMMY ║ │
│║ └──FUP:INSPECTION Inspection-Block fuer SD A338║ │
│╚═══════════════════════════════════════════════════════════╝ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
└────────────────────────────────────────────────────────────────────────────────┘
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8.7 Contracting and Zooming Tree Objects

The tree of a large project may be relatively difficult to survey.  In this case it is possible to contract the
segments of a cluster or a signal group to a single line or to zoom an object.  A tree with contracted or
zoomed objects gives a better project overview.

Each tree object to be contracted or zoomed must be selected first.  The selected objects are displayed
inverse.  The following items in the 'Layout' menu section are helpful to select the objects:

 - Level Up (menu short cut: Left Arrow key): Moves the cursor to the next higher level.

 - Level Down (menu short cut: Right Arrow key): Moves the cursor to the next lower level.  If no lower
level is available, the 'Next' function is performed.

 - Previous (menu short cut: '-' key): Moves the cursor to the previous object on the same level.  If no
previous object on the same level is available, the 'Level Up' function is performed.

 - Next (menu short cut: '+' key): Moves the cursor to the next object on the same level.  If no next object
on the same level is available, the 'Level Down' function is performed.

 - Page Up (menu short cut: 'Page Up' key): Moves the cursor one page up.

 - Page Down (menu short cut: 'Page Down' key): Moves the cursor one page down.

 - Line Up (menu short cut: Up Arrow key): Moves the cursor one line up regardless of the level.

 - Line Down (menu short cut: Down Arrow key): Moves the cursor one line down regardless of the level.

 - Select (menu short cut: Space Bar): Selects the currently pointed object and the sub tree starting there.
The selected object are displayed inverse.  This function works as a toggle function select/deselect.

┌────────────────────────────────────────────────────────────────────────────────┐
│ Windows System Enter Select Layout Print View Setup Options │
│╔════════════════════════════════╔═════════════════╗════════╗ │
│║PROJECT DEBUG ║Contract Alt/C║ ║ │
│║ ├──CL:@MONITOR ║Expand Alt/E║ ║ │
│║ │ └──FUP:@MONITOR ║Zoom Alt/Z║ ║ │
│║ ├──CL:PTSPARAM-TEST-01 ║Unzoom Alt/U║ ║ │
│║ │ ├──FUP:SEG-01 ║Level Up ─ ║ ║ │
│║ │ ├──FUP:SEG-02 ║Level Down ─ ║ ║ │
│║ │ └──FUP:SWITCH0 ║Previous - ║ ║ │
│║ ├──CL:TESTCLUSTER ║Next + ║ ║ │
│║ │ ├──FUP:FRED0 ║Page Up PgUp ║ ║ │
│║ │ ├──FUP:PARAM ║Page Down PgDn ║ ║ │
│║ │ └──FUP:SWITCH0 ║Line Up ─ ║ ║ │
│║ └──CL:UTILITY ║Line Down ─ ║ ║ │
│║ ├──FUP:DUMMY ║Select Space║ ║ │
│║ └──FUP:INSPECTION In║Help ║ SD A338║ │
│╚════════════════════════════════╚═════════════════╝════════╝ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
└────────────────────────────────────────────────────────────────────────────────┘

8.7.1 Contracting and Expanding Already Selected Tree Objects

The 'Contract' function in the 'Layout' menu section allows to contract already selected tree objects.  Use
the 'Expand' item to uncontract the objects ('Expand' is the reverse function of 'Contract').

e. g. the contracted segments in the cluster 'TESTCLUSTER' are now displayed as a single line only.
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┌────────────────────────────────────────────────────────────────────────────────┐
│ Windows System Enter Select Layout Print View Setup Options │
│╔═══════════════════════════════════════════════════════════╗ │
│║PROJECT DEBUG ║ │
│║ ├──CL:@MONITOR ║ │
│║ │ └──FUP:@MONITOR ║ │
│║ ├──CL:PTSPARAM-TEST-01 ║ │
│║ │ ├──FUP:SEG-01 ║ │
│║ │ ├──FUP:SEG-02 ║ │
│║ │ └──FUP:SWITCH0 ║ │
│║ ├──CL:TESTCLUSTER ║ │
│║ │ └── ║ │
│║ └──CL:UTILITY ║ │
│║ ├──FUP:DUMMY ║ │
│║ └──FUP:INSPECTION Inspection-Block fuer SD A338║ │
│║ ║ │
│║ ║ │
│╚═══════════════════════════════════════════════════════════╝ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
└────────────────────────────────────────────────────────────────────────────────┘

8.7.2 Zooming and Unzooming Already Selected Tree Objects

The 'Zoom' function in the 'Layout' menu section allows to display an already selected object. The
unselected objects are hidden.  Use the 'Unzoom' item to unzoom the object ('Unzoom' is the reverse
function of 'Zoom').

e. g. the segments in the cluster 'TESTCLUSTER' are now zoomed and displayed on the screen.  The
unselected objects are hidden.

┌────────────────────────────────────────────────────────────────────────────────┐
│ Windows System Enter Select Layout Print View Setup Options │
│╔═══════════════════════════════════════════════════════════╗ │
│║PROJECT DEBUG ║ │
│║ └──CL:TESTCLUSTER ║ │
│║ ├──FUP:FRED0 ║ │
│║ ├──FUP:PARAM ║ │
│║ └──FUP:SWITCH0 ║ │
│║ ║ │
│║ ║ │
│║ ║ │
│║ ║ │
│║ ║ │
│║ ║ │
│║ ║ │
│║ ║ │
│║ ║ │
│╚═══════════════════════════════════════════════════════════╝ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
└────────────────────────────────────────────────────────────────────────────────┘
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8.8 Printing out the Project Documentation

In order to print out the project documentation the listing type and the printer type must be selected and the
printer parameters must be set up.

8.8.1 Selecting the Listing Type

The 'Select' item in the 'Setup' menu section is used to select the listing type.

┌────────────────────────────────────────────────────────────────────────────────┐
│ Windows System Enter Select Layout Print View Setup Options │
│ ╔══════════════╗ │
│ ║Select ║ │
│ ║Normal Printer║ │
│ ║Post-Script ║ │
│ ║Help ║ │
│ ╚══════════════╝ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
└────────────────────────────────────────────────────────────────────────────────┘

A selector form with a 'Post-Script' and a 'Normal' radio button is opened which allows to select the
appropriate listing type.

┌────────────────────────────────────────────────────────────────────────────────┐
│ Windows System Enter Select Layout Print View Setup Options │
│ │
│ │
│ │
│ │
│ │
│ ╔ Select ════════════════════════╗ │
│ ║ ║ │
│ ║ ┌Listing Type──┐ ║ │
│ ║ │. Post-Script │ ║ │
│ ║ │. Normal │ ║ │
│ ║ └──────────────┘ ║ │
│ ║ ║ │
│ ║ ║ │
│ ║ █▀▀▀▀▀▀▀▀▀▀█ ╔══════════╗ ║ │
│ ║ █ OK █ ║ Cancel ║ ║ │
│ ║ █▄▄▄▄▄▄▄▄▄▄█ ╚══════════╝ ║ │
│ ╚════════════════════════════════╝ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
└────────────────────────────────────────────────────────────────────────────────┘

8.8.2 Setting up the Printer Parameters

The 'Normal Printer' and the 'Post-Script' item in the 'Setup' menu section allows to set up printer
parameters. Depending on the selected listing type ('Select' item), the 'Normal Printer' or the 'Post-Script'
menu item is disabled. After the selection the 'Post-Script' or the 'Normal' printer parameter setup form is
opened.
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┌────────────────────────────────────────────────────────────────────────────────┐
│ Windows System Enter Select Layout Print View Setup Options │
│ ╔ Post-Script ══════════════════════════════════════════════════════════╗ │
│ ║ Footer Frame : ┌Format───────┐ ║ │
│ ║ FUP Height : 98__ ┌───────────────┐ │. Portrait │ ║ │
│ ║ │ no footer ││ │. Landscape │ ║ │
│ ║ FUP Width : 119_ │A3A4 │ └─────────────┘ ║ │
│ ║ │A4 │ ║ │
│ ║ Form Length : 840__ │Q3Q4 │ X-Scale : 1.000__ ║ │
│ ║ │ ││ ║ │
│ ║ Form Width : 595__ └───────────────┘ Y-Scale : 1.000__ ║ │
│ ║ ║ │
│ ║ Listing Length : 700__ FUP Font : NewCourier_______ ║ │
│ ║ ║ │
│ ║ Footer Position : 724__ FUP Font Scale : 7____ ║ │
│ ║ ║ │
│ ║ Top Margin : 36___ Text Font : NewCourier_______ ║ │
│ ║ ║ │
│ ║ Left Margin : 65___ Text Font Scale : 10___ ║ │
│ ║ ║ │
│ ║ ║ │
│ ║ ╔══════════╗ ╔══════════╗ █▀▀▀▀▀▀▀▀▀▀█ ╔══════════╗ ║ │
│ ║ ║ Load ║ ║ Dump ║ █ Save █ ║ Cancel ║ ║ │
│ ║ ╚══════════╝ ╚══════════╝ █▄▄▄▄▄▄▄▄▄▄█ ╚══════════╝ ║ │
│ ╚═══════════════════════════════════════════════════════════════════════╝ │
│ │
└────────────────────────────────────────────────────────────────────────────────┘

Several predefined setups are available for normal and Post-Script printers.  After pressing the 'Load' button
a file selector form is opened which allows to select the printer setup file.

┌────────────────────────────────────────────────────────────────────────────────┐
│ Windows System Enter Select Layout Print View Setup Options │
│ ┌ Post-Script ──────────────────────────────────────────────────────────┐ │
│ │ Footer Frame : ┌Format───────┐ │ │
│ │ FUP Heigh╔File Selector═════════════════════════════════════╗ │ │ │
│ │ ║ ║ │ │ │
│ │ FUP Width║ Filename : .\*.POS_______________________ ║──┘ │ │
│ │ ║ ║ │ │
│ │ Form Leng║ C:\USER\PROJEC_X ║00__ │ │
│ │ ║ ┌──────────────────────────┐ ║ │ │
│ │ Form Widt║ │ .\ ││ ║00__ │ │
│ │ ║ │..\ │ ║ │ │
│ │ Listing L║ │A3A4.POS │ █▀▀▀▀▀▀▀▀▀▀▀▀▀▀▀█ ║ │ │
│ │ ║ │A4.POS │ █ OK █ ║ │ │
│ │ Footer Po║ │Q3Q4.POS │ █▄▄▄▄▄▄▄▄▄▄▄▄▄▄▄█ ║ │ │
│ │ ║ │ │ ║ │ │
│ │ Top Margi║ │ │ ╔═══════════════╗ ║ │ │
│ │ ║ │ │ ║ CANCEL ║ ║ │ │
│ │ Left Marg║ │ │ ╚═══════════════╝ ║ │ │
│ │ ║ │ │ ║ │ │
│ │ ║ │ ││ ║ │ │
│ │ ╔═════║ └──────────────────────────┘ ║════╗ │ │
│ │ ║ Lo╚══════════════════════════════════════════════════╝el ║ │ │
│ │ ╚══════════╝ ╚══════════╝ █▄▄▄▄▄▄▄▄▄▄█ ╚══════════╝ │ │
│ └───────────────────────────────────────────────────────────────────────┘ │
│ │
└────────────────────────────────────────────────────────────────────────────────┘

The printer setup file must be a text file with a certain syntax. After the 'OK' button was pressed, the file would
be parsed and if no error occurred, the read printer setup would be filled into the printer setup form.

The default file extension for the printer setup file is *.HP for HP Laserjet printers or *.POS for Post-Script
printers.  A predefined set of such files resides in the FUPLA 2 system directory and may be copied into the
work directory, where they can be modified (if necessary) using the 'Dump' function.

To modify the printer parameters if required, select the footer frame, the paper sheet format, the character or
the number of the setup item to be selected or modified.  Delete a character or a number first and enter the
correct one.  Select the next character or number to be modified or the 'Save' button to save the settings and
close the form.  Select the 'Cancel' button to close the form without saving.

Legend of Post-Script printer settings:

FUP Height 98 : Number of character rows of a FUP/ALS chart
FUP Width 119 : Number of character columns of a FUP/ALS chart
Form Length 840 : Length of a paper sheet in 1/72 inch (e. g. for A4 portrait: 864 = 12 inch endless

paper, 840 = 296 mm = 11 inch on Laserprinter)
Form Width 595 : Width  of a paper sheet in 1/72 inch (e. g. for A4 portrait: 595 = 210 mm

endless paper, 572 = 202 mm paper with on Laserprinter)
Listing Length 700 : in 1/72 inch. Each time a list page exceeds this length, a pagebreak is

executed.
Footer Position 724 : in 1/72 inch. For normal printers it defines the upper left corner of the footer

frame.  The footer position must be greater than the listing length plus the top
margin.  In the Post-Script mode the footer position defines the lower left
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corner of the footer frame.  In this mode the footer position may be smaller than
the top margin.  In this case you get a header instead of a footer.

Top Margin 36 : Position on the page top where the Documenter starts printing in 1/72 inch
(e. g. 0 if the (laser) printer makes a top margin already big enough, 24 = 1/3
inch = 8 mm).

Left Margin 65 : Position on the left of a page where the Documenter starts printing in 1/72 inch

Footer Frame: (The available footer frames resides in the library PTSRSC.LIB)
no footer : No footer is printed.
A4 : Footer for DIN A4 portrait format, X/Y-scale: 1.0
A3A4 : Footer for DIN A4 portrait format, X/Y-scale: 0.69
Q3Q4 : Footer for Q4 landscape format, X/Y-scale: 0.69

Fonts:
FUP Font : Character set for the FUP/ALS chart, should be a fixed pitch font.
FUP Font Scale : No. of characters per inch
Text Font : Charakter set for text, may be a proportional font.
Text Font Scale : No. of characters per inch

Format:
Portrait : A4 paper sheet format, height: 297 mm, width: 210 mm
Landscape : Q4 paper sheet format, height: 210 mm, width: 297 mm

Scaling Factors:
X-/Y-Scale : Scaling factors to enlarge or reduce the FUP/ALS chart size.

NOTES: The two special fonts 'NewCourier' and 'NewHelvetica' support the
special German characters 'ä', 'ö' and 'ü'.
For cross references a fixed pitch font like 'NewCourier' is highly
advisable.
The list length should be a multiple of the FUP font scale and the
text font scale. Otherwise the last printed line in a listing is clipped
partially.
Be sure to type in a valid Post-Script font which is supported
by your Post-Script printer.

Legend of normal printer settings:

The normal printer settings are nearly identical to the Post-Script printer settings with the following
exceptions:

Footer Frame:
no footer : No footer is printed.
A4 : Footer for A4 format.
A3 : Footer for A3 format.
Q4 : Footer for Q4 format.

Printer Type: (The available printer drivers resides in the library PRINTER.LIB)
ASCII : for printers using only ASCII characters
DEC : for printers using the simple DEC character set
HPLASER : for HP Laserjet and HP Deskjet, portrait format (used for A4 format)
HP_LAND : for HP Laserjet and HP Deskjet, landscape format (used for Q4 format)
IBMPC : for IBM Proprinters or compatibles
LA50 : for DEC's LA50 or compatibles
OKI93 : for OKI Microline 93, A4 paper sheet format



PSR-How to use FUPLA 2 / 8. Documenter 101

Rev.: 4.0 (2001.05) 3BHS 120511 E

TEXTONLY : creates text files using the full IBM PC character set but without printer specific
escape sequences.  See appendix B - How to Insert FUP-Segment Charts into
a WinWord Document.

┌────────────────────────────────────────────────────────────────────────────────┐
│ Windows System Enter Select Layout Print View Setup Options │
│ ╔ Normal ═══════════════════════════════════════════════════════════════╗ │
│ ║ Footer Frame : FUP : Text : ║ │
│ ║ FUP Height : 70__ ┌───────────────┐ ┌Char/Inch┐ ┌Char/Inch┐ ║ │
│ ║ │ no footer ││ │. 5 │ │. 5 │ ║ │
│ ║ FUP Width : 130_ │A3 │ │. 6 │ │. 6 │ ║ │
│ ║ │A4 │ │. 8.25 │ │. 8.25 │ ║ │
│ ║ Form Length : 840__ │Q4 │ │. 10 │ │. 10 │ ║ │
│ ║ │ ││ │. 12 │ │. 12 │ ║ │
│ ║ Form Width : 572__ └───────────────┘ │. 16.5 │ │. 16.5 │ ║ │
│ ║ └─────────┘ └─────────┘ ║ │
│ ║ Listing Length : 625__ Printer Type : ┌Line/Inch┐ ┌Line/Inch┐ ║ │
│ ║ ┌───────────────┐ │. 4 │ │. 4 │ ║ │
│ ║ Footer Position : 643__ │ASCII ││ │. 6 │ │. 6 │ ║ │
│ ║ │DEC │ │. 8 │ │. 8 │ ║ │
│ ║ Top Margin : 0____ │HPLASER │ └─────────┘ └─────────┘ ║ │
│ ║ │HP_LAND │ ┌Pretty Print┐ ║ │
│ ║ Left Margin : 0____ │IBMPC ││ │. on . off │ ║ │
│ ║ └───────────────┘ └────────────┘ ║ │
│ ║ ║ │
│ ║ ╔══════════╗ ╔══════════╗ █▀▀▀▀▀▀▀▀▀▀█ ╔══════════╗ ║ │
│ ║ ║ Load ║ ║ Dump ║ █ Save █ ║ Cancel ║ ║ │
│ ║ ╚══════════╝ ╚══════════╝ █▄▄▄▄▄▄▄▄▄▄█ ╚══════════╝ ║ │
│ ╚═══════════════════════════════════════════════════════════════════════╝ │
│ │
└────────────────────────────────────────────────────────────────────────────────┘

The Documenter allows to save the currently loaded printer setup into a text file by pressing the 'Dump'
button.  A file selector form is opened which allows to enter the file name with the keyboard.

8.8.3 Printing out the Project Documentation

The 'Print' menu section allows to select the kind of list file to be created:

Front Page: Creates a front page listing. The content filled into this page is taken from the form 'Front
Page Data'. Its default file name is FRONTPAG.LST.

Tree: Creates a listing of the currently displayed structure.  Depending on the current tree, the default list
file name is SegTree.LST, GrouTree.LST, TaskMap.LST, SigMap.LST or MacTree.LST.

Charts: Creates a listing which contains the charts of the selected segments or the selected macros. The
default list filenames are SegChart.LST or MacChart.LST.

Charts + Xref: Creates a listing which contains the charts of the selected segments and builds a signal
cross reference, ordered by segments. The default list filename is SegChart.LST.

Xref: Creates a listing of the signal cross reference.  If the current tree is the segments or the task map
tree, a signal cross reference ordered by cluster\segments will be created.  The default list file name is
SegXRef.LST. If the current tree is the signal groups or the signal map tree, a signal cross reference
ordered by signal groups will be created.  The default list file name is GrouXRef.LST.

Parameters: Creates a listing of the parameters.  If the current tree is the segments or the task map tree,
a listing of the cluster local parameters is created.  The default list file name is LocParam.LST.  If the
current tree is the signal groups or the signal map tree, a listing of the global parameters is created.
The default list file name is GloParam.LST.

Configuration: Creates a listing of the configuration manager text file ConfMana.CFM.
Text File: Creates a listing of any given ASCII text file. A file selector appears which allows to select a file.

The given file must be a standard ASCII text file which may contain ASCII form feed characters (ALT
12) to force a page break. Print text file allows to create listings of further project documentation not
included into the project database.  The default list file name is concatenated out of the given text file
name and the file extension '.LST'

NOTE: To print out other than the front page, the configuration or any text
file, select first the cluster and/or segment, the signal group, the
task or the macro with the 'Select' command.
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┌────────────────────────────────────────────────────────────────────────────────┐
│ Windows System Enter Select Layout Print View Setup Options │
│ ╔═════════════╗ │
│ ║Front Page ║ │
│ ║Tree ║ │
│ ║Charts ║ │
│ ║Charts + Xref║ │
│ ║Xref ║ │
│ ║Parameters ║ │
│ ║Configuration║ │
│ ║Text File ║ │
│ ║Help ║ │
│ ╚═════════════╝ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
└────────────────────────────────────────────────────────────────────────────────┘

After the selection of the list file a print form is opened which allows to modify the page number, the file name,
or the printer port if required.  The list file is create and printed out after pressing the 'Print' button.  Pressing
the 'Cancel' button closes the form without creating a list file.

NOTE: The Documenter supports the printer ports LPT1, LPT2 and LPT3.
If the 'only' radio button is selected, a list file only will be created.

┌────────────────────────────────────────────────────────────────────────────────┐
│ Windows System Enter Select Layout Print View Setup Options │
│ │
│ │
│ │
│ │
│ ╔ Print ═════════════════════════════════════════════════╗ │
│ ║ ║ │
│ ║ Printer : Post-Script_____ ┌List File─┐ ║ │
│ ║ │. only │ ║ │
│ ║ Frame : A4______________ │. to LPT1 │ ║ │
│ ║ │. to LPT2 │ ║ │
│ ║ Page Number : 1___________ │. to LPT3 │ ║ │
│ ║ └──────────┘ ║ │
│ ║ Filename : FRONTPAG.LST____________________________ ║ │
│ ║ ║ │
│ ║ █▀▀▀▀▀▀▀▀▀▀█ ╔══════════╗ ║ │
│ ║ █ Print █ ║ Cancel ║ ║ │
│ ║ █▄▄▄▄▄▄▄▄▄▄█ ╚══════════╝ ║ │
│ ╚════════════════════════════════════════════════════════╝ │
│ │
│ │
│ │
│ │
│ │
│ │
└────────────────────────────────────────────────────────────────────────────────┘

8.9 The 'View' Menu

The 'View' menu section contains three items 'Xref', 'Parameters' and 'Help'. The 'Xref' and 'Parameters'
functions are available within the 'Print' menu. There is only one significant difference: 'Print' creates a list file.
'View' allows to (pre-) view the signal cross reference listing and the parameter listing.

The 'Xref' function allows to view the signal cross reference. Depending on the kind of  the current tree all
signals used in a segment or all signals of  one or more signal groups are shown.  If the current tree contains
either the segments or the task map, in this case, only a single segment should be selected. The cross
reference of the first selected segment is displayed only.

The 'Parameters' function distinguishes between two cases:  If the current tree contains either the segments
or the task map, in this case, all cluster local parameters of the selected clusters will be shown.  If the current
tree contains either the signal groups or the signal map, in this case, all parameters of the selected signal
groups will be shown.

The 'Help' function starts an on line help.
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┌────────────────────────────────────────────────────────────────────────────────┐
│ Windows System Enter Select Layout Print View Setup Options │
│╔═══════════════════════════════════╗ ╔══════════╗ │
│║PROJECT DEBUG ║ ║Xref ║ │
│║ └──BUS:TESTBUS ║ ║Parameters║ │
│║ ├──PSR:RECHNER1 ║ ║Help ║ │
│║ │ ├──TASK:INTERRUPT0 ║ ╚══════════╝ │
│║ │ ├──TASK:INTERRUPT1 ║ │
│║ │ ├──TASK:INTERRUPT2 ║ │
│║ │ ├──TASK:INTERRUPT3 ║ │
│║ │ ├──TASK:INTERRUPT4 ║ │
│║ │ ├──TASK:INTERRUPT5 ║ │
│║ │ ├──TASK:INTERRUPT6 ║ │
│║ │ ├──TASK:INTERRUPT7 ║ │
│║ │ ├──TASK:BACKGROUND ║ │
│║ │ │ ├──CL:TESTCLUSTER ║ │
│║ │ │ │ ├──FUP:PARAM ║ │
│║ │ │ │ ├──FUP:FRED0 ║ │
│║ │ │ │ └──FUP:SWITCH0 ║ │
│║ │ │ └──CL:@MONITOR ║ │
│║ │ │ └──FUP:@MONITOR ║ │
│║ │ └──TASK:INIT ║ │
│║ └──PSR:RECHNER2 ║ │
│║ ├──TASK:INTERRUPT0 ║ │
│║ ├──TASK:INTERRUPT1 ║ │
│╚═══════════════════════════════════╝ │
└────────────────────────────────────────────────────────────────────────────────┘

8.10 The 'Options' Menu

The 'Options' menu section supports a menu item 'Charts' which allows to change the settings for the chart
display. Both the Editor and the Documenter allow to modify the chart options, and both use the same chart
options for the chart listings and for the chart windows.

┌────────────────────────────────────────────────────────────────────────────────┐
│ Windows System Enter Select Layout Print View Setup Options │
│ ╔══════╗ │
│ ║Charts║ │
│ ║Help ║ │
│ ╚══════╝ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
│ │
└────────────────────────────────────────────────────────────────────────────────┘

After selecting the 'Charts' menu item a form is opened which allows to select a few options to modify the
chart structure:

Constants:
Short Pins The value of the constants are shown directly at the function block input pin.
Long Pins The value of the constants are shown on the left side of the FUP-chart.

Parameters:
Values The value of the parameter are shown in the FUP-chart.
String 'Parameter' The parameter values are suppressed. The string 'Parameter' is displayed.

Segment Locals:
Show Name The names of the segment local signals are displayed.
Hide Name The names of the segment local signals are not displayed.

Execution Order:
Show Block Numbers The function blocks are numbered according their execution order.
Hide Block Numbers The function blocks are not numbered.
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Globals: Globals more precise means: Cluster local and global signals, long pin segment
local signals, and long pin constants in FUP-charts.  All signals in ALS-charts.

Show HW-Address Show the hardware address of all global signals.  If the HW-address is not
available, 'n. a.' is displayed.

Show DB-Ref Show the data base reference of all global signals.
none Do not show additional information.

Locals: Locals more precisely means: Short pin constants, short pin output signals.
 Show HW-Address Show the hardware address of all local signals.  If the HW-address is not

available, 'n. a.' is displayed.
Show DB-Ref Show the data base reference of all local signals.
none Do not show additional information.

Print Abstracts: Abstracts more precisely means: Additional text in a segment, inserted with the
"Abstract" function in the "Enter" menu of the graphic editor.

Yes The abstracts are printed out.
No The abstracts are not printed out.

┌────────────────────────────────────────────────────────────────────────────────┐
│ Windows System Enter Select Layout Print View Setup Options │
│ ╔ Chart Options ═════════════════════════════╗ │
│ ║ ║ │
│ ║ ┌Constants──────┐ ┌Parameters───────────┐ ║ │
│ ║ │. Short Pins │ │. Values │ ║ │
│ ║ │. Long Pins │ │. String 'Parameter' │ ║ │
│ ║ └───────────────┘ └─────────────────────┘ ║ │
│ ║ ┌Segment Locals─┐ ┌Execution Order──────┐ ║ │
│ ║ │. Show Name │ │. Show Block Numbers │ ║ │
│ ║ │. Hide Name │ │. Hide Block Numbers │ ║ │
│ ║ └───────────────┘ └─────────────────────┘ ║ │
│ ║ ┌Globals───────────┐ ┌Locals────────────┐ ║ │
│ ║ │. Show HW-Address │ │. Show HW-Address │ ║ │
│ ║ │. Show DB-Ref │ │. Show DB-Ref │ ║ │
│ ║ │. none │ │. none │ ║ │
│ ║ └──────────────────┘ └──────────────────┘ ║ │
│ ║ ┌Print Abstracts───┐ ║ │
│ ║ │. Yes │ ║ │
│ ║ │. No │ ║ │
│ ║ └──────────────────┘ ║ │
│ ║ ║ │
│ ║ █▀▀▀▀▀▀▀▀▀▀█ ╔══════════╗ ║ │
│ ║ █ OK █ ║ Cancel ║ ║ │
│ ║ █▄▄▄▄▄▄▄▄▄▄█ ╚══════════╝ ║ │
│ ╚════════════════════════════════════════════╝ │
└────────────────────────────────────────────────────────────────────────────────┘


